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Introduction 
In 2000- 2001, the International Hurricane Center (IHC) of Florida International 

University (FIU) was awarded grant funding by Federal Emergency Management 
Division (FEMA) and the Florida Department of Community Affairs (FLDCA), for a 
program entitled the Windstorm Simulation and Modeling project.  Four tasks under this 
three year project included 1) the re-evaluation of existing storm surge; 2) data 
acquisition of high-resolution elevation data via LIDAR technology for participating 
South Florida counties; 3) computer simulation of findings for researchers and the 
general public; and 4) development of public awareness and education programs in 
regards to human vulnerabilities to hurricanes and the means to mitigate the risks.  This 
project was also supported partially from matching funds provided from participating 
counties. 

  
In 2000-2002, Florida International University (FIU) collected LIDAR 

measurements in eastern Broward and Palm Beach Counties.  These data were processed 
and delivered to the Counties in the form of ASCII text point (x,y,z) files and gridded 
digital elevation models (DEMs).  These datasets are also now available on the Internet at 
URL, http://gis.ihc.fiu.edu/website/lidar. 

 
This workshop will explore applications of digital elevation models (DEMs) 

derived from airborne LIDAR measurements.   The following exercises will demonstrate 
techniques for reading, visualizing, and analyzing gridded LIDAR data collected for 
these studies.  The exercises will use ArcView GIS software and requires both the Spatial 
Analyst and 3-D Analyst extensions.  It is assumed that the user will have some 
familiarity with both ArcView and its Spatial Analyst Extension.  Sample datasets, 
scripts, and documentation required for these exercises are included on a CDROM.   

Background 
Airborne LIDAR (an acronym for Light Detection And Ranging) is an active 

remote sensing technology, which sends pulses of laser light toward the ground and 
detects the return times of back-scattered energy in order to determine ranges to the 
surface.  Most LIDAR systems consist of three basic components (Figure 1): the laser 
scanner, the Inertial Measurement Unit (IMU), and a kinematic Global Position System 
(GPS).  The laser scanner measures ranges to targets on a zig-zag shaped pattern beneath 
the flight path.  Meanwhile, GPS and IMU measurements allow a continuous and precise 
determination of the aircraft’s position and orientation.  Data are recorded in flight and 
are later post processed to return X, Y, Z coordinates of the ground surface.  Additional 
data analysis and filtering allows separation of non-surface features from the terrain 
surface.  Finally, irregularly spaced points are usually interpolated onto a regularly 
spaced grid to produce a DEM. 

 
In 2000-2002, Florida International University (FIU) collected LIDAR 

measurements in eastern Broward and Palm Beach Counties to assist emergency 
management personnel in revising their hurricane evacuation maps.  Elevations were 
collected with an Optech ALTM 1210 LIDAR mapping system jointly owned and 
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operated by FIU and the University of Florida.  Data were collected as a series 600-
meter-wide swaths consisting of points spaced approximately every 2.5 m (8 ft). beneath 
the flight path.  Flight lines were spaced 500 m apart to allow sufficient overlap in order 
to avoid data gaps and to assess measurement repeatability.  Each deployment typically 
took 4-5 hours during which GPS data were continuously recorded on both the aircraft 
and on the ground.  In total 160 separate swaths consisting of over 700 million 
measurements were collected.   

 

The processing of the LIDAR measurements consisted of several steps and 
resulted in a variety of different datasets (Figure 2).  Initially, measurements from 
individual swaths were output as 9 column ASCII text files containing the pulse time, the 
first pulse return (x,y,z coordinates and intensities) and the last pulse return.  Then, the 
first and last return data were separated into two different data streams.  Since the first 
returns often correspond to features such as buildings and trees, this stream was used to 
produce an unfiltered “top surface” dataset.  In contrast, since the last return can 
correspond to the ground return beneath the canopy in vegetated areas, the last stop 
returns were used to produce the “bare earth” elevation data.  For both data streams, 
horizontal coordinates were transformed from UTM coordinates to NAD83, State Plane, 
FL East zone feet and elevations were converted from GPS ellipsoidal heights to 
NAVD88 orthometric heights with the NGS GEOID99 model.   

 
Figure 1.  Schematic diagram showing the components of a typical airborne 
LIDAR system and the acquisition parameters used in the FIU data collection in 
2000-2002. 
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Data from overlapping swaths were checked for internal consistency, combined 

and subdivided into smaller and more manageable sized portions.  These “tiles” consisted 
of 5000 by 5000 ft blocks, each containing from 1 – 2 million points.  The first return 
data for each tile was gridded using kriging interpolation with a linear variogram model 
and a 50 ft search radius to produce a set of 5 ft resolution, (1000x1000), DEMs.  This 
DEM resolution was selected to be consistent with the 8 ft nominal point spacing.   

 
The 2nd return data consists of a 3-dimensional cloud of points corresponding to 

laser reflections off various objects.  In order to model and visualize variations in the 
ground surface, reflections from non-ground features such as buildings, vegetation, and 
vehicles must be classified and removed.  Since a given DEM pixel can often contain 
both ground and non-ground surface reflections, terrain classification is best performed 
on the raw, irregularly spaced laser points rather than on gridded data.  After 
classification, the remaining ground surface points were gridded to produce a set of 5 ft 
resolution “bare earth” DEMs for each tile.  As with the top surface data, kriging 
interpolation was used, except that a 150 ft search radius was used to interpolate over 
gaps left by removing vegetation and buildings. 
 

For modeling and display purposes, a lower resolution dataset was produced by 
subaveraging the bare earth 5 ft pixels to 100 ft resolution.  First a 21x21 focal mean 
filter was applied to each of the bare earth 5 ft resolution DEM tiles.  Then the tiles were 
resampled by a factor of 20.  Finally the tiles were mosaiced to form the 100 ft DEM  
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These subaveraged grids are comparable in horizontal resolution to the familiar USGS 30 
m DEMs. 
 

Exercises 
The exercises below require the ArcView Spatial Analyst and 3-D Analyst 

extensions.  Materials for the exercises are provided on the CD.  Before starting the 
exercises, create a workspace directory on your hard disk named arcws.  Copy all the 
files in the sourcedata directory on the CD to your arcws directory.  Make sure that the 
full path name to arcws does not contain any spaces.  For example, the path, 
C:\exercises\arcws is correct whereas the path C:\My Documents\exercises\arcws will 
cause an error.   

Exercise 1: Data Import and Visualization 
The gridded LIDAR datasets are distributed as ESRI Binary Raster format.  The 

binary raster file format is a simple format that can be used to transfer raster data between 
various applications.  It consists of two files, the IEEE floating-point file and a supporting 
ASCII header file. The header file must have the same name as the data file, but with a 
.hdr file extension.  The data file will be a matrix of 32 bit signed IEEE floating-point 
values. The file will have a line of binary numbers for each row in the data set. The first 
line of data is the top row of the data set, moving from left to right. The binary raster file 
format can only be imported or exported using the Spatial or 3D Analysts.  A description 
of this format can be found in the on-line help under importing.  In this exercise, we will 
learn to import data from a tile into an ESRI GRID.   
 
Step 1: Start ArcView, and load the extensions.   

Start ArcView and create a new view.  Make the View active.  From the File 
menu � choose Extensions and check Spatial Analyst and 3-D Analyst.   

 
Click OK 

 
Step 2: Set the Working Directory 

The Spatial Analysis extension is notorious for generating lots of files.  In the 
Windows Explorer, create a sub-directory named arcws.  Save your files and 
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datasets in this directory.  Make the View active and change the Work Directory 
(File menu� choose Set Working Directory) to this directory in order to 
prevent datasets from being written to C:\temp.   

 
 
Make sure to use the full path to this directory including the drive letter. 

 
Step 3: Import the “bare earth” and “top surface” LIDAR grids. 

Make the view active, in File � Import Data Source and select Binary Raster.   

 
 
Navigate to the arcws directory and select the file, 940000_695000_z.flt.  This file 
contains the top surface DEM for the tile with lower left coordinates, 940000, 
695000. 
 
Click OK.  Name the grid 940_695t.  Click OK.  Add the grid as a theme to the 
View. 
 
In a similar manner, import and name the 3 remaining grids: 

945000_695000_z.flt  � 945_695t 
940000_695000_zf.flt � 940_695b 
945000_695000_zf.flt � 945_695b 

 
The latter 2 grids correspond to the “bare earth” DEMs for each tile. 
 

Note: The Binary raster file format can also be imported using other methods 
1. In ARC/INFO with the command line FLOATGRID command or GRID 

function. 
2. In ArcToolbox: with Import to Raster �Floating Point Data to Grid 
3. In another GIS/ Image Processing package with a generic binary float read 

and using the appropriate information in the .hdr file 
For more information of the ESRI Binary Raster Format, see the help under: 
Importing data from generic raster files 
 
Compare the Grid Theme Properties to the lines in the .hdr file.  Make the Grid 
Theme, 945_695t, active and zoom to the theme extents.  Then, go to the Project 
(.apr) window and open a New script.  In the Script menu, select Load Text File 
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, , and load the file 940000_695000_z.hdr (alternatively, you can open this file 
in a text editor).  Now examine the Theme Properties, , for 945_695t.  
Understand the relationship between the theme corner coordinates (Left, Right, 
Bottom, Top) and the keywords in the .hdr file. 
 

Q1a: Calculate the coordinates of the NE corner of the grid in terms of NCOLS, 
NROWS, XLLCENTER, YLLCENTER, and CELLSIZE. 

 
 
 
Step 4:  Visualizing the Elevation Grids 

Color-coding is a common method for visualizing topographic surfaces .  In 
color-coding, each elevation pixel is assigned a color on the basis of a lookup 
table (LUT, sometimes referred to as a colormap).   
 
By default, ArcView assigns a monochromatic colormap which is stretched 
between the minimum and maximum grid values.  Note how the color ranges of 
the top surface and bare earth DEMs differ, making it difficult to compare the two 
surfaces. 
 
The default colormaps can be altered by editing the legends for each grid theme.  
Make the theme, 945_695t, active and double click on the legend to open the 
legend editor.  At this point, you may choose to edit the legend by manual or 
automatic classification and by selecting a different color ramp.  We have saved 
you some time by creating a legend file.  Click Load and select the legend file,   
0-50topo.avl and click OK.  Click Apply in the Legend Editor. 
 
Repeat this process for the other surfaces.  Compare the top surface grids with the 
bare earth grids.  Are you able to identify buildings and vegetation? 
 
Shaded relief images are also useful for visualizing and interpreting surfaces.  To 
create a relief image, make the grid theme active and select Compute Hillshade 
from the Surface menu.  Complete this operation for the grid themes 945_695_t 
and 945_695_b. 
 
Note: Compute Hillshade creates a temporary grid that is given an arbitrary name 

such as hlshd2.  Temporary grids are deleted when you exit ArcView unless 
they are made permanent.  To make a grid permanent, either save the 
project, in which case the grid will retain its original name, or select Save 
Data Set in the Theme Menu, at which time you will be prompted for a new 
name. 

 
Color mapped grids my be combined with a shaded relief image to produce a 
color shaded relief image.  To make a color shaded relief image, edit the grid 
theme legend and select Advanced.  Select the appropriate hillshade layer as the 
Brightness theme.  Click OK and Apply. 
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Step 5: Create 1 foot contours 

Contours also provide a useful means for visualizing surfaces.  Spatial Analyst 
provides a useful tool for generating contours from grids.  Contouring involves 
the weaving of isolines between the pixels of the grid to give the illusion of 
terrain.   
 
Contour the bare earth elevations for tile 945000_695000.  First, make the grid 
theme, 945_695_b active.  Then select Create Contours from the Surface menu.  
Enter a Contour interval  of 1, base contour of 0.  Click OK.   
 
The contour shapefile will be added to the view.  Turn the contour theme on.  
Compare the contours to the grid theme.  Which one do you feel is more useful 
for understanding the ground surface? 

 
Step 6:Overlay orthophotos on the elevation grids 

Digital orthophotos are created from aerial photographs and are a common source 
of geospatial information.  LIDAR elevation grids can provide a useful tool in the 
interpretation and use of this imagery.  Similarly, orthophotos can be extremely 
useful in interpreting LIDAR elevations. 
 
One foot resolution digital orthophotos of each tile, 940_695.tif and 945_695.tif 
are located in the arcws directory.  Make the view active and add these 
orthophotos as image themes, .  Turn the image themes on and then move 
them below the grid themes in the View legend. 
 
Zoom to the extent of 945_695.tif.  Compare the bare earth and top surface grids 
with the orthophotos.  Consider the following questions: 
1. Examine the top surface grid theme, 945_695t.  Identify the parts of the grid 

that have the value of NODATA.  Compare this NODATA region on the 
orthophoto.  To what feature does this NODATA region correspond?  Why 
might there be no LIDAR elevations over this type of feature? 

2. Examine the bare earth grid theme, 945_695b, at the same location.  Is there 
any NODATA here?  If not, why (Consider the different search radii used for 
gridding each of these layers)? 

3. Zoom to the forested area in the NW quadrant of the tile.  By comparing the 
bare earth and top surface grids, the contours, and the orthophoto, determine 
how effective the filtering process is in heavily wooded areas. 

 
Zoom to the extent of 940_695.tif.  Zoom into the residential area in the SW 
quadrant of the tile.  Compare the bare earth and top surface grids with the 
orthophotos.  Note how using LIDAR elevations with the orthophotos is more 
effective in identifying ground features than orthophotos alone. 
 

Save your project as Ex1.apr.  We will use the same grid and image themes in the next 
exercise. 
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Exercise 2: Information Extraction 
LIDAR elevation data is a potentially rich source of information that can be applied to a 
variety of disciplines.  ArcView Spatial Analyst provides several tools for querying and 
extracting elevation data.  Some of these tools are available from the default menus and 
buttons such as the Identify tool, , on the View button bar.  Others are accessible from 
Avenue scripts.  In this exercise, we will learn to extract elevation information at points, 
along lines or profiles, and within polygons. 
 
Step 1: Point query and extraction. 

One common practice is to compare the values of lidar elevations with elevation 
data determined by a method of higher accuracy such as conventional surveying.  
This procedure is known as “ground truthing”, and is necessary in order to 
evaluate the accuracy of a given dataset.  In this step, we will interpolate the 
elevations of the LIDAR grids to the locations of points in a shapefile.  An 
Avenue script, gridspot.ave, located in the arcws directory, will interpolate the 
values of the elevation grid to each point and write the results to a field in the 
point attribute file.  Gridspot is modeled after the ARC command, 
LATTICESPOT and uses the Avenue function pointvalue which interpolates the 
value at a point from the values of the 4 nearest grid cell centers. 
 
Zoom to the extents of tile 945_695.  Click the Add Theme button, , and load 
the shapefile Pba_profile.shp.  This theme contains the x,y,z coordinates of a 
ground survey profile collected on the taxiway of the airport.  Turn the theme on.  
Open and examine the theme table, .   
 
Create a new script and make the script window active.  Select the Load Text File 
icon, , and load the file, gridspot.ave.  Edit the script properties and name the 
script gridspot.  Compile the script by clicking on the  icon.  

 
Go back to the View window and 
make the Pba_profile.shp theme 
active.  Then, select the gridspot 
script window and click the Run 
icon, .  You will be prompted to 
select a surface theme.   
 
Select the bare earth grid, 
945_695b.  Use the default name, 
945_695b for the spot field.  Click 
OK. 
 
Go back to the View window and make the Pba_profile.shp theme active.  Open 
the theme attribute table.  Notice how a new field, 945_695b, containing the spot 
elevations has been added to the table.  Repeat the above procedure with the top 
surface grid, 945_695t, adding a similarly named field. 
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The ground truth data may be compared with the interpolated surface values by 
means of a scatter plot.  ArcView has some capability for plotting scatter plots, 
however, it is very poor.  In order to view our extracted data, we will export it to a 
text file and graph it in M.S. Excel. 
 
First, make the attribute table active.  Then from the File menu, select Export.  
Export to a Delimited text file named pba_profile.txt.  Now, start Excel.  Open the 
file as comma delimited text.  Then using the chart wizard, graph the 3 elevation 
values. 
 

Step 2: Extracting elevations along a profile 
Extracting elevations from a surface along a line is known as profiling.  Profiles 
are often used to visualize elevation changes along linear features such as streams 
or road centerlines.  In order to construct a profile, surface values are interpolated 
to points located at specified intervals between vertices of a line or polyline.  In 
this step, we will use some of the built-in functions in 3-D Analyst to extract and 
graph profiles from surfaces.  This function allows profiles to be extracted from 
either 3-D line graphics or from 3-D shape files.  The surface providing the 
heights may be either a grid or a TIN.   
 
To extract a profile from a 3-D line graphic, make the View window active and 
zoom to the extent of 945_695.tif, the image of the airport.  Make only the TIF 
image visible by moving it to the top of the legend; this theme will serve as a 
reference for drawing your profile line.  Then, make the grid theme 945_695b 
active; this theme will provide the heights for the profile line. 
 
Choose the Interpolate Line tool, , from 
the toolbar.  Bring the cursor into the view 
window over the NW end of Runway14 (the 
NW-SE trending runway) and click the 
mouse.  Move the cursor to the SE end of 
the runway and double click (you may add 
intermediate vertices by single clicking).  
This will create a 3-D graphic.  
 
Move to the Project window, select Layouts 
and create a new Layout.  Select the Profile 
Graph tool, .  Using the cursor, define the 
area on the page where you want the graph.  
In the Profile Graph Properties dialog, 
choose the view containing the selected 3D 
lines that you want to graph.  Choose 
appropriate numbers for the X and Y axis Grid lines. 
 
Profiles may also be extracted from line themes.  Load the shapefile, 
pomp_r5.shp.  In order to extract a profile from this shape, it first needs to be 



 11

converted to a 3-D shapefile.  First, activate the theme and select Convert to 3D 
Shapefile from the Theme menu.  Get the Z values from Surface, selecting 
945_695b, as the height source.  Use the default sample distance.  Click OK.  
Name the theme pompr5_3d and add the theme to the View.  Make the view 
active. Finally, open a Layout and in a manner similar to the previous example, 
create a profile graph. 
 
More elegant options for extracting profiles can be found in ARCPLOT, ArcMap, 
or in user submitted Avenue scripts available at the ESRI website. 

 
Step 3: Polygon Zonal stats: height and base 

Load the polygon theme houses.shp.  Open the attribute table.  The attribute table 
contains fields corresponding to a unique id for each house as well as empty fields 
for the base elevation, top elevation, and height.  The Summerize Zones function 
will be used to calculate the mean base and top elevation for each house.   
 
In the Analysis menu, select Summarize Zones. Select the Id field to define the 
zones.  Then, select the grid theme 940_695b to define the base elevation of each 
house.  Click OK.  Next, choose the Mean, for the statistic to chart.   
 
This procedure will create a theme table (named: Stats of 940_695b Within Zones 
of Houses.shp) containing various statistics for each house.  In order to assign the 
mean elevation for each house to the Baseelev field in the attribute table, we will 
have to join the tables.  First, make the stats table active.  Select the Id field.  
Next, open the theme attribute table for houses.shp and select the Id field.  
Finally, select Join from the Table menu.  This operation will append the 
statistics to each record in the attribute table. 
 
In order to assign a value to the 
Baseelev field, select Start Editing 
from the Table menu table.  Then 
select the Baseelev field.  Next, select 
Calculate from the Field Menu. The 
field Calculator will open.  Double 
click on the Mean field and click OK.  
Finally, select Remove All Joins from 
the table menu. 
 
Repeat the above procedure using 
Summarize Zones for the grid theme, 
940_695t.  Similarly, join the statistics to the attribute table and assign the Mean 
to the Topelev field with the field calculator.  Again, select Remove All Joins 
from the table menu. 
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Finally, calculate the height of each house by subtracting Baseelev from Topelev 
in the Field Calculator.  When you are done, select Stop Editing from the Table 
menu and save your edits.   
Save your project as Ex2.apr.   

Contents of the CD 
The CD included with this manual contains materials used in the exercises as well as 
other data of interest.   
 
LIDARworkshop.pdf Adobe PDF file of this manual 
 
sourcedata Materials used the exercises.  All coordinates are in State 

Plane, FL East zone, NAD83 Feet 
Top Surface 5 ft LIDAR DEMs 

940000_695000_Z.flt, 940000_695000_Z.hdr 
945000_695000_Z.flt, 945000_695000_Z.hdr 

 
Bare Earth Surface 5 ft LIDAR DEMs 

940000_695000_Zf.flt, 940000_695000_Zf.hdr 
945000_695000_Zf.flt, 945000_695000_Zf.hdr 

 
1 ft resolution orthophotographs provided by Broward Co. 

940_695.tif, 945_695.tif 
Scripts and Legends 

0-50topo.avl Legend file at 5 ft categories for displaying 
elevations 0 - 50 ft 

gridspot.ave Avenue Script for interpolating spot elevations from 
a grid to points in a shapefile. 

Shapefiles 
pba_profile.shp Points surveyed at Pompano Beach Airport 
pomp_r5.shp Runway 5 
houses.shp  
 

samples Sample datasets and scripts.  All coordinates are in State Plane, FL East 
zone, NAD83 Feet unless otherwise specified 

 
strip_a1.asc.gz Compressed 9 column (t,x1,y1,z1,x2,y2,z2,i1,i2) strip file. 

Horiz coordinates are in UTM17 NAD83 meters, heights 
are ellipsoidal meters 

 
940000_695000_150.asc.gz Compressed Top Surface x,y,z Point files 
945000_695000_150.asc.gz 
 
940000_695000_150f.asc.gz Compressed Bare Earth x,y,z Point files 
940000_695000_150f.asc.gz 
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Broward_sub100.flt, Broward_sub100.hdr Subaveraged 100 f LIDAR DEMs 
Pbeach_sub100.flt, Pbeach_sub100.hdr 

  
vertcon94e.asc   Vertcon Grid (ASCII raster import format) for SE United 

States (Decimal Degrees, 0.05 deg interval) 
 

br_pb_tileindex_dd.shp Tile index 
 

altm_scatter.ave 
 

 

Contact Information 
Any question about this manual should be directed to: 
 
Dr. Dean Whitman 
Department of earth Sciences 
Florida International University 
Miami, FL  33199 
Tel: (305) 348-3089 
Email: whitmand@fiu.edu 
 
 


